
 

 

 

 

 

 

 

 

 

 

 

 

Knowledge-Based Nontraditional Engagements is designed to help the practitioner efficiently and effectively perform 
nontraditional engagements in accordance with applicable standards issued by the American Institute of Certified Public 
Accountants (AICPA). The knowledge-based methodology for nontraditional engagements is a risk-based methodology for 
conducting nontraditional engagements. It emphasizes using knowledge of the entity, subject matter, and suitable criteria to perform 
procedures and, when applicable, make risk assessments and recommendations in connection with an engagement. Nontraditional 
engagements are often unique and complex, and require specialized accounting, attestation, and consulting knowledge. Conducting 
nontraditional engagements requires the exercise of the practitioner’s professional judgment. This edition includes specific up-to-
date guidance for nontraditional engagements and is published for the purpose of communicating, to users of the toolset, updates 
and enhancements included in the current version. This document is not, and should not be used as an engagement program to 
update the documentation of an engagement started in a previous version of this product. 
 
The methodology is presented in terms of its application for attestation and consulting-based engagements including: 

 Examination-Level Attestation Engagements; 

 Review-Level Attestation Engagements; 

 Agreed-Upon Procedures Engagements (General); 

 Examination-Level Engagements on Prospective Financial Statements; 

 Compilation Engagements on Prospective Financial Statements; 

 Agreed-Upon Procedures Engagements on Prospective Financial Statements; 

 Examination-Level Engagements on Pro Forma Financial Information; 

 Review-Level Engagements on Pro Forma Financial Information; 

 Engagements to Report on the Effectiveness of an Entity’s Internal Control over Financial Reporting or Management’s 
Written Assertion (Integrated with an Audit of Financial Statements); 

 Examination-Level Engagements on an Entity’s Compliance with Specified Requirements or the Responsible Party’s 
Written Assertion; 

 Agreed-Upon Procedures Engagements on an Entity’s Compliance with Specified Requirements or the Responsible Party’s 
Written Assertion; 

 Examination-Level Engagements on Management’s Discussion and Analysis; 

 Review-Level Engagements on Management’s Discussion and Analysis; 

 Engagements to Report on Controls at a Service Organization (SOC 1); 

 Engagement to Report on Controls at a Service Organization Relevant to Security, Availability, Processing Integrity, 
Confidentiality, and Privacy (SOC 2); 

 Due Diligence Engagements: Buyer’s Assistance; 

 Due Diligence Engagements: Seller’s Assistance; 

 Risk Assessment Engagements; and 
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Welcome to the latest version of 2014 Knowledge-Based Nontraditional Engagements (7/31/14), 
the latest title available in the ProSystem fx® Knowledge Coach series!  

 

Please review this bulletin prior to installation and use. If you have any questions, call Technical 

Support at 1-800-PFX-9998, option 4.  



 PrimePlus Services Engagements. 
 
The methodology emphasizes the processes through which information or knowledge flows through the engagement process. The 
tools in this edition have been developed in accordance with authoritative guidance including the Statements on Standards for 
Attestation Engagements (SSAEs), Statements on Standards for Consulting Services (SSCSs), and related AICPA standards and 
requirements.  
 
This is the third update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the 
Knowledge Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.  
 
The 2014 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis 
related to the steps and processes discussed in the workpapers.  
 
For more information on the Knowledge-Based Methodology and how it works within ProSystem fx® Knowledge Coach, refer to the 

Additional Information section in this bulletin. 

 

WORKPAPER NOTES 
 
Note: There are 5 separate content packages for the Knowledge-Based Nontraditional Engagements title.  The five packages are 
listed below.  All of these packages only require one license to be assigned to the user in the Admin Module. Please see the section 
Installation Instructions below for more information. 

 Knowledge-Based Nontraditional Engagements – Examinations  

 Knowledge-Based Nontraditional Engagements – Reviews  

 Knowledge-Based Nontraditional Engagements – Compilations  

 Knowledge-Based Nontraditional Engagements - Agree-Upon Procedures  

 Knowledge-Based Nontraditional Engagements – Consulting  

Important Note for Customers updating binders from 2011 through 2013 Knowledge Based Nontraditional Engagements  

You must install Engagement 7.1 and Knowledge Coach 2.1 and 2014 Financial Statement Base v2 (7/31/14) before updating to the 
2014 Knowledge Based Nontraditional Engagement titles.  
 
If you have already downloaded and added the 7/18/14 version of the Financial Statement Base Title in order to use the 2014 
Commercial title, you must deploy the Knowledge Coach Content Update (7/31/14) before updating to the 2014 Knowledge -
Based™ Nontraditional Engagement titles. For more information on 2014 Financial Statement Base v2 (7/31/14) or the latest 
Knowledge Coach Content Update, review the release notes at http://support.cch.com/updates/KnowledgeCoach/ 
 

General Roll Forward Note 

You must be the current editor of all Knowledge Coach workpapers to update to the latest content during roll forward, and you 
must be the current editor upon opening the updated workpaper for the first time to ensure you see the updated workpaper. 

The 2014 Knowledge-Based Nontraditional Engagements tools have been updated to take into account new or pending 
professional standards and guidance, including the requirements of Government Auditing Standards (GAGAS), 2011 Revision; and 
references to auditing standards where applicable. The 2014 edition of Knowledge-Based Nontraditional Engagements is current through 
SSAE-17. Users of this content should consider guidance issued subsequent to these items to determine their effect on entities 
covered by this product.  

 

Specific Program Enhancements 

For more information on specific program enhancements, review the 2014 Nontraditional Engagements Overview for Knowledge 
Coach users available at the following link or in the binder through the KCO-001 workpaper. 
https://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/KCO-
001%202014%20Nontraditional%20Engagements%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf 

http://support.cch.com/updates/KnowledgeCoach/
https://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/KCO-001%202014%20Nontraditional%20Engagements%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
https://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/KCO-001%202014%20Nontraditional%20Engagements%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf


 

In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take into 

account: 

 
New literature, standards, and developments, reflected in the following current audit and accounting guidance:  

  

AICPA Guide, Reporting on Controls at a Service Organization (“COSO”) Relevant to User Entities’ Internal Control over Financial Reporting 
(SOC 1)  
AICPA Guide, Prospective Financial Information  
 
The 2014 Knowledge-Based Nontraditional Engagements also features numerous enhancements, including: 

 Eliminated duplication of steps were possible 

 Streamlined process for when the auditor is not testing the operating effectiveness of internal controls in the Examinations 
title 

 Certain workpapers have been completely re-written to be used with the 2013 Version of the COSO Integrated Internal 
Control Framework 

 
  



Additional Information on Knowledge Coach and the KBA Methodology 

Knowledge-Based™  Methodology for Nontraditional Engagements — Allows the results of one set of procedures to become the input for the next. 

The Knowledge-Based™  Methodology for Nontraditional Engagements includes the following key components: 

 An Overview that guides practitioners through the methodology; 

 Knowledge-Based Attestation documents, integral to the overall engagement processes, that contain steps and 
procedures required by professional standards; 

 Customizable Engagement Programs that take practitioners through procedures required by professional standards; 

 Practice Aids to help practitioners complete steps or processes outlined in the overall engagement programs; 

 Practitioner’s Reports that provide a variety of sample practitioner’s reports on nontraditional engagements; and 

 Correspondence documents that provide sample engagement and representation letters to be used to comply with 
professional standards, SSAE and SSCS requirements, and in other common situations. 

 

The practice aids and tools in the 2014 Knowledge-Based Nontraditional Engagements are designed to assist practitioners by: 

 Facilitating compliance with professional standards;  

 Encouraging more effective engagements through tailored engagement programs and comprehensive practice aids;  

 Helping practitioners to focus on the subject matter and suitable criteria, and when applicable respond to identified risks; 
and 

 Enhancing engagement documentation. 
 

ProSystem fx® Knowledge Coach 

ProSystem fx® Knowledge Coach functionality allows auditors to use the Knowledge-Based methodology more efficiently by 

eliminating the need for duplicate entry of the same information, tailoring documentation to each particular engagement. ATT-100 

Tailoring Question Workpaper or CON-100 Tailoring Question Workpaper is a document in Knowledge Coach that presents engagement-

level questions designed to aid in tailoring the engagement documentation to fit each client. Completing the questions helps the 
auditor avoid duplication and unnecessary workpapers.  

Before you begin your engagement, please review the guidance in ATT-101 through ATT-114 Overall Attestation Programs and CON-101, 

CON-102, CON-104, and CON-106 Overall Engagement Programs. These workpapers are intended to be your road map through a 

Knowledge-Based methodology.  You should start your engagement with ATT-100 Tailoring Question Workpaper and ATT-101 through 

ATT-114 Overall Attestation Programs or CON-100 Tailoring Question Workpaper and CON-101, CON-102, CON-104, and CON-106 Overall 

Engagement Programs. 

Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent 

information ensures that information and updates to information are not missed between workpapers. Drill-down functionality 
helps the user navigate quickly to the source of the information, aiding in the review of the engagement file. 

Diagnostics help you keep track of unresolved issues like unanswered questions, missing workpaper, and more. Diagnostics now 

show when a form table has not been answered. 

Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes nontraditional engagement content, you 

can link directly to source material from Resources within Knowledge Coach documents. Also, if you subscribe to the Knowledge-
Based Nontraditional Engagements Guide on ARM, you can take advantage of links to the engagement guide material from within the 
Knowledge Coach documents. 

Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane. Informational 

features include Practice Points, Examples, Optional Workpapers, and Resources to help practitioners work more effectively and 
efficiently. We have also added the ability to navigate from Resources within a document or the tip pane directly to CCH’s 
Accounting Research Manager and industry guides by simply clicking on the Reference. 

 

 



Important Notes 

 Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated. 

 If your Current Editor Knowledge Coach MS Word workpapers become read-only or crash, please do the following: 
o Keep the binder with the affected workpapers open. 
o Highlight the workpaper in the binder window with and go to Tools>Save Knowledge Coach Answers 

 Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach 
workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central 
file room and through peer-to-peer sync in the same way other Engagement workpapers are shared. 

System Requirements 

 This title MUST be used with ProSystem fx Engagement version 7.1 and ProSystem fx Knowledge Coach version 2.1 and 
higher. If you are upgrading from a previous version of ProSystem fx Engagement, please contact Technical Support at 1-
800-PFX-9998, option 4 for detailed instructions. 

 A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx 
Knowledge Coach documents. 

Download Instructions 

Download the 2014 Knowledge-Based Nontraditional Engagements from the ProSystem fx Knowledge Coach Updates section of the 
ProSystem fx Engagement Support Web site at the following URL: http://support.cch.com/updates/KnowledgeCoach, then select 
the Knowledge Coach Series and Download file link next to the 2014 Knowledge-Based Nontraditional Engagements. On 
some occasions the content package file (.KCP) has downloaded with the extension changed to .ZIP. If this occurs, please change 
the extension of the downloaded file to KCP using all capital letters. 
 
Important: ProSystem fx Engagement version 7.1 or higher and Knowledge Coach version 2.1 must be installed on the computer in 
order to install this Knowledge Coach title. Additional requirements include Microsoft Office 2007, Microsoft Office 2007 Primary 
Interop Assemblies (PIA), Visual Studio 2005 Tools for Office Second Edition Runtime, Visual Studio Tools for Office System 
Runtime version 3.0, Visual Studio Tools for Office System 3.0 Runtime Service Pack 1, Visual Studio Tools for Office Runtime 4.0 
(VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS). 
 
The following 2014 Knowledge-Based Nontraditional Engagements (7/31/14).KCP download is a proprietary file that must be 
installed from within Engagement. Save this KCP file to a location on your local drive, and follow the Installation Instructions 
included in the Release Bulletin. 

Installation Instructions 

Once you have downloaded your Knowledge Coach title or Financial Statement Base title, you will need to add it to the list of titles 
within ProSystem fx Engagement. The only additional system requirement is approximately 75MB of disk space to store your 
Knowledge Coach program content files. Please refer to the ProSystem fx Engagement with Knowledge Coach Release Notes for 
any other system requirements.  
 
After downloading the 2014 Knowledge-Based Nontraditional Engagements titles, do the following: 
 

1. Launch the ProSystem fx Engagement Workpaper Management application so that the Local File Room is 
displayed. Select Tools > Knowledge Coach Titles.  

 The Knowledge Coach Titles window will be displayed.  
2. Choose Add Title.  
3. Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx Knowledge Coach 

Support Web site.  
4. Choose Open.  
 The system will display a progress indicator while the title package is added. You will receive a message that the 
 title has been successfully installed once the process is complete. 

 

http://support.cch.com/updates/KnowledgeCoach


Once the title is added, you must release it, so that other staff members in your firm can use it. You may also wish to “unrelease” 
previous versions of the title. 
 
To unrelease a title: 
 

1. Select a version of the KBA NTE title. 
2. Choose Unrelease Title. The date will be removed from the Date released column and staff that do not have the 

staff group property right to insert unreleased titles will not be able to insert the unreleased titles into a binder.   
 
Note: You can determine this access in the ProSystem fx Engagement Admin module by selecting a staff group and 
choosing File > Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option. 

 
To release a title:  
 

1. Select one of the Knowledge Coach titles in the list that has been added but is not yet released.  
2. Choose Release Title. The current date and time will be displayed in the Date released column, and the status will 

change to “Released.”  
Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the  
ProSystem fx Engagement Administrator before using the workpapers.  

Important: Once the 2014 Knowledge-Based Nontraditional Engagements titles have been added and released, they will be 
automatically deployed to other staff members when they login to the “Office” location, or when they synchronize a binder 
that contains Knowledge Coach workpapers from this title.  

Online Permission Key 

Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx  
or when adding or updating the new licenses within ProSystem fx Engagement with Knowledge Coach version 7.1 and higher. After 
updating the license file in the ProSystem fx Engagement Admin module, licenses need to be assigned to the staff who will use 2014 
Knowledge-Based Nontraditional Engagements. 
 
If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.  

Permission keys are no longer generally distributed via floppy diskette. You can choose to continue receiving the diskette by going to 

https://prosystemfxsupport.tax.cchgroup.com/service/accountadmin/ , clicking the Firm Administration link, and making the 
appropriate selection (SSO access is required), or by contacting Customer Service at 1-800-PFX-9998, option 4. 
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Figure 1 – New Knowledge Coach Workpaper 

 

Accounting Research Manager 

CCH’s Accounting Research Manager is the most comprehensive, up-to-date and objective online database of financial reporting 
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written 
interpretive guidance.  

Our Weekly Summary email newsletter highlights the key developments of the week, giving you assurance that you have the most 
current information. It provides links to new FASB, AICPA, SEC, EITF, and IASB authoritative and proposal-stage literature, plus 
guidance from financial reporting experts.  

Our team of content experts updates the system on a daily basis, so you can stay as current as possible. What’s more, our experts 
attend critical, standard-setting meetings and summarize the results for you, which means you’ll learn of newly released literature and 
deliberations of current financial reporting projects as soon as they occur! Plus, you’ll benefit from their easy-to-understand technical 
translations. Our expert’s interpretations clearly lay out what the rules mean from your perspective.  

Also available is the Knowledge-Based Nontraditional Engagements, a guide that helps you comply with the most recent 
professional standards and guidance for the conduct of nontraditional engagements and to integrate the use of practice aids, tools, 
and other resources with its guidance. This publication supplements and complements the Knowledge-Based documents that are 
available in Knowledge Coach. 

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more 
about our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. 
You can also access the Accounting Research Manager Web site by selecting the item in ProSystem fx Engagement from the 
Guidance tab on the Shortcuts bar in the Binder window.  
 

Links to Accounting Research Manager (ARM)  

As indicated above, subscribers to an Accounting Research Manager library that includes source content can link directly to source 
material from references within Knowledge Coach workpapers. These links have been updated to reference the new Codification 
released by the FASB and available on ARM. The Codification on ARM is fully integrated with U.S. and international accounting 
standards, other non-authoritative materials and industry leading interpretive guidance.  

 

Using Your Knowledge Coach Content 

To use your Knowledge Coach Workpaper Templates, 
open a binder in ProSystem fx Engagement, select the 
workpaper tab into which you would like to insert the 
workpaper, and select New Knowledge Coach 
Workpaper from the toolbar or File menu. The New 
Knowledge Coach Workpaper dialog appears (Figure 1).  

Select the New Knowledge Coach Title with the 
content you would like to use. You can only select titles 
you have installed. The information displayed changes 
to reflect the workpaper organization available for the 
selected title. Select the Knowledge Coach Workpaper 
Templates to insert into your binder and click OK. The 
Selected Workpaper Properties dialog appears. Each 
workpaper name is automatically loaded into the Name 
field. Add a workpaper index in the Index field and 
make any Name modifications you desire. You can also 
modify the tab location or the roll forward settings for 
each workpaper. Then click OK. The integrated 
Knowledge Coach workpaper is now inserted into your 

http://www.accountingresearchmanager.com/
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engagement binder. For more information on how to use Knowledge Coach workpapers in your binder, see the Knowledge Coach 
User Guide.  

 

Download 
Description: 

2014 Knowledge-Based Nontradtional Engagements 
(7/31/14) 

Version: 
Engagement v. 7.1 with Knowledge Coach 2.1 or higher 
and Financial Statement Base Title v2  7/31/14 

Release Date: July 2014 

File size: 18MB 

Approx. 
Download Time: 

42 minutes at 56 kbps 

License: Full Version 

Platforms: Windows Vista7,8 and 8.1 

Office: Microsoft Office 2007 required 

 Contact Information 

For a demo or to purchase additional titles as they become available 1-800-PFX-9998, option 1 
Technical Support 1-800-PFX-9998, option 4, then option 1 

The ProSystem fx Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by 
CCH, a Wolters Kluwer business. The contact information above can be used for customer service and support issues for this 
product. For information about other CCH products, please call 1-800-248-3248 or visit the online Store at 
http://tax.cchgroup.com. 
 


